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GTSNX 2019 Enhancements

1. Analysis

1.1 New Heat Transfer, Thermal Stress, Seepage-Thermal Stress analysis types (Construction Stage)

GTS NX2019(v2.1) Release Notes

pipelines. In GTS NX thermal energy can be exchanged based on following phenomenological ways: Conduction and Convection.
Thermal analyses (Heat Transfer, Thermal Stress, Seepage-Thermal Stress) are available as the steady state analysis and transient analysis (time dependent).

After the heat transfer analysis, results such as temperature distribution, temperature gradient, heat flow direction / size are printed.

Thermal stress and thermal deformation due to generated/exchanged heat can be obtained from Thermal Stress analysis

(thermo-mechanical study).

Seepage -Thermal Stress analysis allows for hydro thermo mechanical simulation.
Both structural analysis results and seepage / heat transfer analysis results are output.

Analyses are available from Construction Stage define window.

“ k |ﬁ.n Stage Set
& Simulate Stage i Volume Data Export

[H]
Stage L N
Wizard B8 Auto Set
Construction Stage

Construction Stage Set X
Mame Construction Stage Set-1 Add
Stage Type |Stress A Modify

Seepage Copy
Stress-Seepage-Slope
Consolidation Delete
Fully Coupled Stress Seepage
Stress-Monlinear Time History Define C5...
Heat Transfer

Seepage-Thermal Stress

Thermal Stress

Fully Coupled Stress Seepage Heat

Mo

Close

[Construction Stage Set window]

MibAS
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Item ID
@ C:\Users\PIOTR\DesktophGTS M...
-2 Function

.41 History Qutput Probe

&1-[7=8 Boundary Cendition

- [Tk Static Load

-.[158 Dynamic Load

=-[7=H Thermal Load

E‘I-'H Temp 2
- @[l Prescribed Temper..
- fy Heat Flux E

FF&; Heat Flux
I_Q.E Response Spectrum Load
[—j--d Stage 5et
d 3D Tunnel Connetction
5
gl 30-SeepTH
-l 20-Heat
9@ Analysis Case

k@ 3D: Censtruction Stage
<« [

Thermal Analysis

iy Heat Flux A2 Convection
A Heat Source B Define Set
ﬂjﬁPrescribed Ternperature {8 Table -
Load
o [Available thermal loads]
Color
P

Model Analysis Results

[Model with applied thermal loads]

*Available upon request

This analysis type can be used to model the thermal changes in the ground due to environmental changes, or due to the construction of facilities, such as buildings or
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GTSNX 2019 Enhancements

1. Analysis

1.1 New Heat Transfer, Thermal Stress, Seepage-Thermal Stress analysis types (Construction Stage)

Results 3 o=
Item ID Color
El@ 5271 -

B@ INCR=1 (LOAD=1.000)
&4 o Modal Thermal Results
....ﬂp TEMPERATURE
-4g APPLIED HEAT FLOW
-85 REACTION HEAT FLOW
[—]--i%ﬂ 1D Element Thermal Results
- 1D THERMAL GRADIENT X
- 1D THERMAL GRADIENT RESULTANT
-8 1D HEAT FLUX X
- 1D HEAT FLUX RESULTANT
=-45] 2D Element Thermal Results
----- U7 2D THERMAL GRADIENT X (V)
..... U7 2D THERMAL GRADIENT Y (V)
..... U7 2D THERMAL GRADIENT RESULTANT (V)
..... J5] 2D HEAT FLUX X (V)
..... U5 2D HEAT FLUX Y (V)
..... U7] 2D HEAT FLUX RESULTANT (V)
agﬂ Element Thermal Results
..... 4) THERMAL GRADIENT X (V)
..... 4] THERMAL GRADIENT Y (V)
..... 5] THERMAL GRADIENT Z (V)
..... ﬂvﬂ] THERMAL GRADIENT RESULTANT (V)
----- 3 HEAT FLUX X (V) B
..... Y HEAT FLUXY (V)
..... ) HEAT FLUXZ (V)
..... Y HEAT FLUX RESULTANT (V)
-] 527-1[Monlinear Static]
B@ INCR=1 (LOAD=1.000)
; B Displacements
d%z Grid Forces
#2 Reactions b
Qp Truss Element Forces
5 Shell Element Forces
g Truss Element Stresses
5] Shell Element Stresses
ﬂ Solid Stresses
[=-§) Solid Strains

m

Model Analysis  Results

[Every CS output combines Heat
Transfer and Structural results ]

MibAS

GTS NX2019(v2.1) Release Notes

NODAL THERMAL
TEMPERATURE , [T]

———+5.57745e+002
0.1%
———+5.34016e+002
0.4%

4%
+5.10288e+002
o

o

r36.-’

+4.86559%+002
A%
“+4.62830e+002
<

+4.39101e+002
4.7%
+4.15373e+002
6.5%
+3.91644e+002
10.7%
+3.67915e+002
16.7%
——+3.44186e+002
24.0%
——+3.20458e+002
26.2%
+2.9672%+002

<

&%
———+2.73000e+002

[Thermal Stress analysis results for lining thermal expansion analysis]

DIS

PLACEMENT

TOTALT, m

0.1%
0.3

+4.94690e-001
<

o

+4.53466e-001
3%
+4.12242e-001
1.6%

+3.71018e-001
9%

+3.29794e-001
2%

+2.88569e-001

8%
-+2.47345e-001

3%
+2.06121e-001

o,

o
+1.64897e-001

47.2%
+0.00000e+000

*Available upon request

4/12



GTSNX 2019 Enhancements

1. Analysis

1.2 Improving Hyperbolic (Duncan-Chang) Model

= Previously Hyperbolic(Duncan-Chang) material has updated as two types such as Duncan-Chang E-B and Duncan-Chang E-v with additional parameters.

GTS NX2019(v2.1) Release Notes

Material X
s} Name |Isotropic Color ,—| ~
Model Type | Hyperbolic(Duncan-Chang E-B) v Structure
General Porous MNondinear  Thermal

Cohesion(C) 30 | kjm2
R e T LR L L LR
. Frictional Angle(®) 36 | [deg]

SN EEsEEEsEEEEEEEEEEsEEEEAREAAEEEAASEEEsEEEEES .

[IFrictional Angle Increment 0| [deg]

Initial Loading Modulus(k)

Exponent(n) l:l

Failure Ratio(Rf)

Kur [Juser Defined 0

b m = 0

Exponent{m) 0

Min. Tangential Modulus ki fm2

Min. Confining Stress(omin) kMyfm2

Atmospheric Pressure{Pa) kMfm2

Cancel Apply

[Hyperbolic(Duncan Chang E-B)]

Material X
D D Name [Isotropic Color =
Model Type Hyperbolic(Duncan-Chang E-v) ~ Structure

General Porous MNon-inear  Thermal

Cohesion(C)

Frictional Angle()

[ Frictional Angle Increment

Initial Loading Modulus{K)
Failure Ratio(Rf)
........................................

Poisson Ratio Parameters

Interception
Variation rate 1

Variation rate 2

- ;
Exponentt{m) El

Min. Tangential Modulus kijm2
Min. Confining Stress{omin) leM/m2
Atmospheric Pressure(Pa) kijm2

Cancel Apply

[Hyperbolic(Duncan Chang E-v)]

Mesh > Prop./Csys./Func. > Material > Isotropic > Hyperbolic(Duncan-Chang E-B) or Hyperbolic(Duncan-Chang E-v)

[Friction Angle Increment for E-B & E-v]

* In case of “Coarse grained soil”, frictional angle will be decreased

with increased compression (03) so that it will consider this situation.

* Friction angle(®) will be defined by following equation,

03
= 0,—A0 xlog(p—)

a

[Additional parameters for E-v(G, F, D)]

» Parameters have added for calculating Vt(Poisson’s ratio).
G: Distance to axis from initial poisson’s ratio

F: Rate of change for compression from initial poisson’s ratio
D: Rate of change for stress from initial poission’s ratio

» Parameters and limiation are defined by following equation,

03

B m Rf 2
Et - Kpa (pa) [1 - (0_1 _ 0_3)f (01 - 63)]

G—Fxlog(;—3>
a

- ___D(g~03) ’
Kpq (I%) [1 - @f—f%)f (o1 — 03)]

D>0,0<G<05,F<G

MibAS
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GTS NX2019 Enhancements GTS NX2019(v2.1) Release Notes

1. Analysis
1.3 Improving Slope Stability Analysis(SRM)

= Previously it could be got the result of last iteration only. It can find the results from each step which are selected by user from now on.
= SRF1 and SRF2 can use for reduced function such as friction angle and cohesion respectively. And, User can consider dilatancy angle(SRF3) for reduced
function additionally. (%Safety factor function can apply only to Mohr-Coulomb model)

Analysis Case > Analysis Control > Slope Stability(SRM)
Analysis Control * Analysis Control hed
General Dynamic MNonli Slope Stability (SRM) : i Slope Stability(SRM
Enere Zynamic. Tonnesr i) NTH with SRM_noSafetyFactorFunction Generl | Dynamic | Nordineer | Sope StabfSRH)
Define Time i . - - - Define Time
B@ Monlinear Static(ln-situ Analysis)
. e — B W o Ap o - ey N —p
1 0.3 Add =2 Menlinear Time History(In-situ Analysis) 1 0.3 Add
j E: y Modify -1 INCR=5 (TIME=5.000e-002) j g: y Modfy
< > Delete {z INCR=10 (TIME=1.000e-001) < > Delete
-2 INCR=15 (TIME=1.500e-001)
Nonlinear parameters @ INCR=20 mME: ?_.ODDE-OOU Monlinear parameters
Maximum Mumber of Trials | 50 | i @ INCR=25 (TIME=2.500e-001) Maximum Number of Trials | 50 |
Maimum Number of Tterations | 50 | {z IMNCR=30 (TIME=3.000e-001) Maximum Number of Tterations | 50 |
Stiffness Update Scheme Full Newton-Raphson e H @ MIN Stiffness Update Scheme Full M safety Factor Function ]
P e Ll @ A [ — .-E‘:...;j.:;:.......
It et | RLABSOWTEMAX |, MR
Convergence Criteria / Error Tolerance = @ SRM [Tlme 0.3] : Convergence Criteria /Error Tolerance £ ros sur1 e [HE s
[ bisplacement{L) 0.01 E {z INCR=1 (FOS=0.5000) 5 [pisplacement(U) E (Tenie @ 5 o
[ LosdP) 0.01 i @ 2! INCR=2 (FOS=0.6000) : Load() ; 2 = .
[ work(w) 0.0001 i @] INCR=3 (FOS=0.7000) : Cwork(w) : =
i - INCR=4 (FOS=0.2000) : L e L
Safety Factor t a2 INCR=3 (FOS=0.9000) : Safety Factor -
Initial Safety Factor | 0.5 | {Z INCR=6 (FO5=1.0000) Initial Safety Factor o
.{Z INCR=7 (FOS5=1.0250) H : PR : :
Increment of Safety Factor | 0.1| ‘E:I g A S HIStDF};f.JSj'EE.I'.i ."[.T"""""" Increment of Safety Factor o -
Resalution of Safety Factor | 0.05 | @ 2f INCR=1 (TIME=3.000e-001) Resalution of Safety Factor s I
Safety Factor Function ~ 2 @ INCR:=6 (TIME=3.300e-001) E Safety Factor Function Safety Factor Function | -8 5
{z INCR=11 (TIME=4.000e-001) GassEssssEsssEEssssEssssEssssEsssssssssssssssssssssasss’
Advanced Morlinear Parameters. .. {z MIN Advanced Nonlinear Parameters...
a2 MAX
H _OK Cancel
Cancel -2 ABSOLUTE MAX
[SRM - Intermediate Output Request] [Display the FOS from Every Stage] [SRM - Safety Factor Function]
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GTSNX 2019 Enhancements

1. Analysis

1.4 Adding Prescribed Strain Function

GTS NX2019(v2.1) Release Notes

= Prescribed strain function is using to apply volumetric strain by compulsion, can be assumed volume loss from Jet Grouting method or compensation grouting.

(XPrescribed strain will not be supported to linear analysis and dynamic analysis)

Prescribed strain bt

Prescribed strain

Mame Prescribed strain-1

Element Type | sglid e
Object
Type 3D Element w

‘ E Select Object(s) |

E XX | [J| oy,
Doy | D| %
£ _IZ | 0 oy

Tension({+), Compression{-)

Load Set | w | =
G & oK Cancel

[Prescribed Strain]

Static/Slope Analysis or Seepage/Consolidation Analysis > Load > Prescribed strain

[Element Type]
Truss/Embedded Truss, Beam/Embedded Beam, Shell, Plane Strain/Plane Stress, Axisymmetric, Solid

[Strain Component]

Applying volume strain to x, y, z axis

[To apply Prescribed Strain — Solid]

DISPLACEMENT
Z,m
s
e
0% i

[Occurred Displacement]

SOLID STRAIN
E-ZZ, None

[Occurred Strain]
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GTS NX2019 Enhancements GTS NX2019(v2.1) Release Notes

2. Pre/Post Processing
2.1 Load Table import/export for thermal analyses

Cards for thermal loads has been added to manage large amount of data.
Users can import the amounts of load sets from excel file and export defined load sets (node/element number, magnitude, and direction) as well.

The sample of table for load sets (Load Table Sample.xlsx) can be found in the installation folder. (ex. C:\Program Files\MIDAS\GTS NX\Sample)

Thermalload - Excel

Draw Page Layout Formulas Data Review View Help Foxit PDF P Tell me what you want to do |& Share

= _ e EE General - ﬁ%ComﬂitionalFormattingv E‘“Insert LD I 27'
o : | e $-% GFDrmatasTab\e' E" Delete - E' P~
S=E=E=E TaR GCeIIStyIS' EIFormat' & -
Clipboard = Font [F] Alignment | Mumber ] Styles Cells Editing
Al A 2 **Unit, kN, m, J, sec
A B | C | D | E | F G
1 |=Unit, kN, m, J, sec
P Load Set Name Node ID Function Temperature Time Function Time Type /
3 [Temp Prescribed Tempe 4049 None 273 None Global <3 ﬂ |
4 Temp Prescribed Tempe 4050 None 273 None Global .
5 [Temp Prescribed Tempe 4051 None 273 None Global ‘ I/‘/
6 |Temp Prescribed Tempe 4052 None 273 None Global L//
7 [Temp Prescribed Tempe 4053 None 273 None Global - /_/
8 |Temp Prescribed Tempe 4054 None 273 None Global /,/
| Pressure | Gravity | Heat Flux | Prescribed Temperature | ® [ — //
Ready B o - 1 L+
1 |1
/
[Thermal Load Set to import] =
L1 | —
/
/
/
/ /
//
/
E =

[Imported Temperatures and Heat Fluxes]

MibpAS 8/12



GTSNX 2019 Enhancements

2. Pre/Post Processing

2.2 Database for Unsaturated Soil

GTS NX2019(v2.1) Release Notes

= Previously, It was inputted (6,., 6;. a, n) by user manually. It will be used for reference from database of those parameters which are provided by GTS NX from
now on. (¥ Permeability has inputted as default value. Porosity will be applied to analysis which is provided by Add/Modify function. This database will be

using for reference of permeability from soil type)

A o saturated io b'Y
Mame Type Add T
Modify
Delete
Database
Close

[Database for Unsaturated Function]

Select Database

| —

~

Automatically generate
selected function

Scale Factor

e

Functon Name Permeabiity Graph Option

[sendstone(rygiene) | xaxsiogscake [Jv-arislogscae  [x-axslog scale

X

Water Content Graph Option

[ t-axis log scale

Permeabilty

M=1-1/n) 0.903846154

|

1000

Water Content Function Data

Function Type |Van Genuchten ~

M=1-1/n) 0.903846154

Function Type |Van Genuchten v .
\ a 07 fn
1

"

"

"

"

"

"

"

"

13

Redraw Graph

[Automatically import Database]

hosiy

Mesh > Prop./Csys./Func. > Function > Unsaturated Property > Database

.......... w0
N
Database = Van Genuchten data(1980) S (w Select all Unselect All
[ e e e e e e e e e e e e ey
H No | Soil | Ks (m/sec) | Bs{m=/m=) | ar(m?/m2) | a(1/m) | n | Select |2
= 1 Sandstone({Hygiene) 1.25e-005 0.25 0.153 0.79 10.4 =) H
H 2 5ilt Loam(Touchet) 3.50594e-005 0.469 0.19 0.5 7.09 |} H
H 3|Silt Loam 5.74074e-007 0.396 0.131 0.423 2.06 1] H
H 4 Loam(Guelph_drying) 3.65741e-006 0.52 0.218 115 2.03 (=] H
ol .
H 5 Loam{Guelph_wetting) 0 0.434 0.218 2 2.76 = H
H 6 Clay(Beit Netofa) 9,49074e-009 0.446 0 0,152 w7, O H
N AR AN ER AN E R AN ERA A ERA A EA AN ARAAERAAARAAARAAARAAARAAARAAARAAARAASARAAARAASARAASNNAASNRAASSGAASAGAASSGAAGEGEAGEEEASsEEEEEEES

Reference — A Closed-form Equation for Predicting the Hydraulic Conductivity of Unsaturated Soils
- M. TH. VAN GENUCHTEN, 1980

Select All Unselect All

Database +Van Genuchten data(Carsel and Parrich., 1988) ~|n

Lavesuasasusanranssannsnssansrsssessssnsnsasansnnnnned
H Mo | Soil I Ks (m/sec) I ©s(m?/m3) I Or(m3/m3) I a(1/m) I n | Select |:
[ 1fsand 8.25e-005 0.43 0.045 14.5 268 [ =
| 2/ Loamysand 4.05324-005 0.41 0.057 124 228 [0 |
| 3 sandyloam 1.22801e-005 0.41 0.085 7.5 18s [ |®
H 4 Loam 2.8888%-006 0.43 0.078 3.6 e [ %
1 | ssit 6.944442-007 0.4 0.034 16 137 O |*
I | slsitloam 1,25¢-006 0.45 0.067 2 1s1 B |
H 7 Sandy Clay Loam 3.6388%e-006 0.39 0.1 5.9 148 |} H
i | 8|cayleam 7.2222%-007 0.41 0.085 1.8 131 [ =
E: 9 sit Clay Loam 1.94444¢-007 0.43 0.035 1 123] O 5
|| 10/Sandyclay 3.33333¢-007 0.3 0.1 2.7 3 @ =
s | 11sityClay 5.555562-008 0.36 0.07 0.5 e [ |1
H 12 Clay 5.555562-007 . A 0.8 08 O |
T O o W N rwwe s

Reference — Developing Joint Probability Distributions of Soil Water Retention Characteristics
- ROBERT F. CARSEL and RUDOLPH S. PARRISH, 1988

[Database from Soil Type]

MibAS
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GTS NX2019 Enhancements GTS NX2019(v2.1) Release Notes

2. Pre/Post Processing

2.3 Improving the Interaction between Function Table and Excel

= |t has updated to display real input values with upgrading the base of function table library.
= xls file will be created with Export to Excel function.

Mesh > Prop./Csys./Func. > Function
Add/Modify Unsaturated Function X Add/Modify Unsaturated Function X
Function Name Scale Factor Permeability Graph Option Water Content Graph Option Function Name Scale Factor Permeability Graph Option Water Content Graph Option
1 [ %-axis log scale  []¥-axdis log scale X-axis log scale [ '¥-axis log scale |U”55‘1-"'EtEd Property Function | | 1 | X-axislogscale [ |Y-axislogscale  []X-axislogscale [[]Y-axis log scale
Permeability Function Data Permeability Function Data
0.0L 0.00
Function Type | User Defined ~ Function Type |User Defined v
mEssEEEmEEEEEEEEEEEEEEEEEEEE, 0.0Lz SENssNNssssssEssEEssEEsEEEEEE, 0.012 -
F Pressure | o . : o1 \ H A 0.01 \
- (kN/m?) M \ : Pressure K Ratio H \
HIPEE X . (Iifm2) 1o oo
{ 1] 10.0000 0.0124 = |y \ £ Ik \
HIE R H = |5 .00
4 2| 316230 0.0002 1|4 \\ ' 10 0.0124 © 0 = ‘-\
4 3| 100.0000 00000 k(¥ e AN £ 31623 00002 3 |% e AN
k 4] 316.2300 0.0000 H 0.00: : 100 0 H 0. 00
- H (31.62, 0.0002) : 2o
[ 7922900 o000 : - \ﬁ_!_!_!_l HiC 316.23 c'cu:\
- 6| 1000.0000 0.0000 , = i) 100 1000 A E | . 71429 : Op% L H 100 1000
b H Negative Pore-Pressure (k/m) - : nnn H Paste Ctrl+V % Begasive Pore-Pressure (kH/m?)
SEEEESEEEEEEEEEEEEEEEEEEEEEEEEY CEEEssEssEsEEEEEEEEnn R EEEE M
Water Content Function Data Water Content Function Dsi ’
0.2 H Export to Excel...
Function Type | User Defined v N Function Type |User Definedv svvawaWa v fsvassafrasseasaqovan s .
0.28 0.28
~ ~
Pressure Water AL ™ ATl PR AN
(kN/m=) Content g Pressure Water g
£ o (kijm?) | Content o
1 0.3000 0.3000 a % 3
2 0.6000 0.3000 ¥ oo 0.3 0.3 oo
3| 17384 0.2911 a 0.6 0.3 i
4| 26544 0.2747 & 1.7384 0.2811 &
5| 40437 0.2283 0 26534 0.2747 °
0.1 1 10 4,0437 0.2283 0.1 L 10
—6 4.6935 01976 v Negative Bore-Eressure (EN/m) [ ¥ Fegative Fore-Fressure (EN/m®)
Redraw Graph oK Cancel Redraw Graph Ok Cancel Apply
[Previously Function Table] [Currently Function Table & Export function]
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GTSNX 2019 Enhancements

2. Pre/Post Processing

2.4 Extract from Result of Water Level(Line & Surface)

GTS NX2019(v2.1) Release Notes

= From advanced view control( @ ), coordinate with 3D can be export with text file from result of water level.
= Decreased depth of water level can be defined easily and accurately with this function instead of measure function(F3).

Iso Surface

Iso Value

|

Lock Value While Result Changing

150

(®) Capped Style

() Surface Style

@ Upper Part Cl Lower Part

Add
Delete

Delete All

[Export Function]

Advanced View Control > Iso value surface > Export

[Tunnel : Water level line]

| 2D - Notepad

p,158,0
8,150,0
4,149.604,0
4.4401,149.56,0
8,149.207,8
8.88022,149.12,0
12,148.811,8
13.3204,148.68,0
16,148.414,8
17.7605,148.239,8
20,148.017,8
22.2007,147.799,8
24,147.621,8
26.6409,147.359,8
28,147.224,8
31.0809,146.919,8
32.14A_R2R.A

| 100%  Windows (CRLF)

File Edit Format View Help

UTF-8

" 3D - Notepad

|-8.1525,41.08,37.9715
-0.734618,41.08,37.975
-1.50188,41.08,37.9691
-3.61944,41.08,37.9715
-4.65125,41.08,37.9559
-2.85125,41.08,37.9797
-2.08109,41.08,37.9732
-5.39805,41.08,37.9547
-6.45125,41.08,37.956
-7.1939,41.08,37.9535
-8.2505,41.08,37.9574
-8.98661,41.08,37.9495
-19.0505,41.08,37.9402
-10.7635,41.08,37.9308
-11.8505,41.08,37.9155
-12.5307,41.08,37.9035
-13 ARAQ7 41 AR 37 RRA

[Excavation : Water level surfage] windous cun

File Edit Format View Help

UTF-8

[Decreased pore pressure]

[Decreased pore pressure]

11/12



GTSNX 2019 Enhancements

2. Pre/Post Processing

2.5 Extract with Word Formation from Input Parameter

= |Information of parameters(General, Porous, Non-Linear) can be exported with image or word file.
= Information will be exported which is using from analysis case only. Analysis steps can be selected for extracting in case of construction stage analysis.

GTS NX2019(v2.1) Release Notes

Tools > Export > Export Material Image

Export Material Image Files
Select Analysis Case
D@ Export Material Image Files
B D@ Excavation
(= mnitial
O= rw
= ex1
O=st
= ex2
=52
= ex3(FEL
Image Format
Image Format PNG e
Cutput Option
Output Type Image hd
D:%0.4 Program Tutorial'®0. 2 GTS N WExcavati %] |
Cancel

X

[Export Material Image]

<1

D Neme | Isotropic Color ~

Model Type | Mohr-Coulomb

General Porous Mon-Linear  Thermal

Elastic Modulus(E)

Inc. of Elastic Modulus

Inc. of Elastic Modulus Ref. Height
Poisson's Ratio(v)

Unit Weight(y)

Initial Stress Parameters

Ko Determination

(®) Automatic
(O Manual

Thermal Parameter

Thermal Coefficent

Molecular vapor diffusion cosfficient
Thermal diffusion enhancement
Damping Ratio(For Dynamic)
Damping Ratio

[ safety Result(Mahr-Coulomb)
Cohesion{C)

Frictional Angle{m)

Tensile Strength

oK

| [structure

Time Dependent
50000 | knyjm2
ki /m3

m

JJ.

kifm2

0.412214748

Anisotropy B}

1e-006 | 111

mafsec

d L

30| kgfme
36 | [deq]

0| kyfmz

Cancel

[General]

vl

D Name  [Isotropic Color =

Model Type | Mohr-Coulomb

General Porous  Non-inear Thermal

Unit Weight{Saturated)
Initial Void Ratio(eq)
[Junsaturated Property
Drainage Parameters
Drained

Undrained Poisson's Ratio

Skempton®s B Coefficent

Seepage & Consolidation Parameters

Permeablity Coefficents

v [structure

Time Dependent

0.495

0.97826087

| o I ky =3
‘ 10005 ] | 1e005 ] | 12005 | mpsec
[ veid Ratio Dependency of Permeability (ck) 0.5

Spexific Storativity(Ss)

5.230213| 1jm iy

Cancel Apply

[Porous]

Model Type

<1

Name |Isotropic Color ™

Mohr-Coulomb

General Porous MNon-linear  Thermal

Cohesion Parameter
(®) Cohesion(C)

Inc. of Cohesion
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GTSNX 2019 Enhancements

2. Pre/Post Processing

2.6 Adding the Extract Function to MIDAS Gen/Civil

GTS NX2019(v2.1) Release Notes

= GTS NX 2019(v2.1) can export *.mgt and *.mct to MIDS Gen and Civil. (¥Over than Gen v875, Civil v875 can be importing this exported file)

= Static linear analysis can be carried out with those files(*.mgt / *.mct) from MIDAS Gen and Civil.

Menu > Export > Midas Gen...

Menu > Export > Midas Civil...

[Mesh with 3D solid]

RESTLTIT
1.36616e-001

3.720440-002
2.48029e-002
1.26018e-002
0.00000+000
scaumncToR.
s.aeE001
‘wioar

DISPLACEMENT
TOTALT, m

|~ +0.00000e-+000

SOLID STRESS
522, kiim~2

1172504003

[Result of Linear Static analysis - DXYZ]

[Result of Linear Static analysis - DXYZ]

[Modeling with MIDAS Gen]
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GTS NX2019 Enhancements GTS NX2019(v2.1) Release Notes

2. Pre/Post Processing

2.7 Dividing Mesh Set with Arbitrary Surface

= After to create mesh from 3D model, 3D mesh set can be divided by arbitrary surface. Dividing location will be determined by large volume under the divided
surface. (% Dividing Surface will be considered only for plane surface. Curved surface is not supported)

= This function is useful to divide mesh set which is created as one mesh. For example, mesh set can be divided two layers of soil from one layer with this divide
function as below.

Mesh > Mesh Set > Divide

Mezh Set o
Rename Copy Create Divide
[ Select Object(s) | Precrnss
AP 4%
Dividing Tools “"‘""“‘;*“'“"4’ s
® = Select Object(s) |
() Three Points Plane
0,0,0
a,0,0
0,00
() Dividing Plane
1 Y z
0/m
Mesh Set
Mame |Mesh Set Division |
Addto  |Mesh v|
ok || Cancel |[ apply ]
[Mesh Set Divide] [Before Dividing]

[After Dividing]
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GTSNX 2019 Enhancements GTS NX 2019(v2.1) Release Notes

2. Pre/Post Processing

2.8 Apply Nonlinear Time History to Type More Than One Stage from Construction Stage Analysis with Stress-Nonlinear Time History
= Previously, Stress-Nonlinear Time History analysis could been applied only 1 stage at last stage. Time history analysis can apply more than one stage.
= Now, only nonlinear time history type can be applied after nonlinear time history analysis stage(Stress analysis type can not be applied after nonlinear time history

analysis stage).
Ex) Stress — Stress — Nonlinear Time History — Nonlinear Time History : OK,
Stress — Nonlinear Time History — Stress — Nonlinear Time History : NG

2.9 Improving Searching Method to Mother Element from Embedded Element

= Algorism has improved to search whether element is deactivated which is designated as mother element form embedded element during construction stage

analysis.
- Computation of every step which is activated embedded element =» Searching the activated element from computed step = Designating & investigating the

mother element from searched elements
= Display the error message for user from difficult to recognize with tiny error which is satisfied with tolerance.
Ex) [error] node[216707] and node[216596] are located almost same but, they are not connected. Please make them same coordinate.

2.10 Changing the Default Method from Auto Connection

= Default method has changed from imprint to Boolean from auto connection function to consider frequency of usage.

2.11 Improving Initialize Function

= Previously, Advanced view control( : = [}l @ _ ) was remained when initialize function applied. Advanced view will not be remained with applying initialize

function from now on.
(Result > etc. > Initialize)
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